Lab S-6: FIR Filter Design GUI

Pre-Lab: Read the Pre-Lab and do all the exercises in the Pre-Lab section prior to attending lab.

Verification: The Exercise section of each lab should be completed during your assigned Lab time and the steps marked Instructor Verification signed off during the lab time. When you have completed a step that requires verification, demonstrate the result to your instructor and answer any questions about it. Turn in the completed verification sheet before you leave the lab.

Lab Homework Questions: The Lab-Homework Sheet has a few lab related questions that can be answered at your own pace. The completed Lab-HW sheet is due at the beginning of the next lab.

1 Pre-Lab

1.1 Objective

The goal of this lab is to learn some methods for designing practical FIR filters in MATLAB. These filters will have a finite number of coefficients, and a frequency response that approximates an ideal frequency response shape.

1. Windowing: The concept of windowing is widely used in DSP when dealing with finite-length signals.

2. Filter Specs: The quality of a designed filter is measured by how closely the actual response matches the desired ideal response. Often the desired match is set prior to the actual filter design step by drawing a tolerance region around the ideal filter shape. Then the minimum-order filter that fits inside the tolerance region is designed.

3. Design Methods: Two very common approaches to FIR filter design are windowing and computer optimization. The filterdesign GUI in the SP-First (or DSP-First) Toolbox can do both.

1.2 Overview

There are many ways to approximate an ideal frequency response with a practical filter. For FIR filters the frequency response \( H(e^{j\omega}) \) is a function of \( \omega \) that summarizes a LTI system’s response to inputs such as complex exponentials and sinusoids. The MATLAB function \( \text{freqz.m} \) is used to compute samples of the frequency response in the frequency domain.\(^1\) A filter design method produces filter coefficients \( \{b_k\} \) for the time-domain implementation of the FIR filter as a difference equation

\[
y[n] = b_0 x[n] + b_1 x[n - 1] + b_2 x[n - 2] + ... + b_M x[n - M]
\]

so the \( \text{freqz} \) function is an essential step for making plots of the magnitude and phase of the designed frequency response and assessing how closely it matches the desired ideal response.

---

\(^1\)If you do not have the function \( \text{freqz.m} \), there is a substitute available called \( \text{freqkz.m} \) in the SP-First (or DSP-First) Toolbox.
1.3 Frequency Response of FIR Filters

The general form of the frequency response for an $M$-th order FIR linear time-invariant system with filter coefficients $\{b_k\}$ is

$$H(e^{j\hat{\omega}}) = \sum_{k=0}^{M} b_k e^{-j\hat{\omega}k} = \sum_{k=0}^{M} h[k] e^{-j\hat{\omega}k} \quad (1)$$

In addition, recall that the impulse response $h[n]$ for the FIR filter has values equal to the filter coefficients.

1.3.1 MATLAB Function for Frequency Response

MATLAB has a built-in function for computing the frequency response of a discrete-time LTI system. The following MATLAB statements show how to use freqz to compute and plot both the magnitude (absolute value) and the phase of the frequency response of an FIR filter whose impulse response is a truncated sinc function. The plots are a function of $\omega$ in the range $-\pi \leq \hat{\omega} \leq \pi$:

```matlab
M = 22; %-- Filter Order is even
nn = 0:M; %-- "n index" vector
nsh = n - M/2; %-- put main lobe in center of h[n]
wb = 0.32*pi; %-- "Bandwidth" parameter of sinc
bb = sin(wb*nsh)./(pi*nsh); %-- Filter Coefficients
bb(find(nsh==0)) = wb/pi; %-- fix the divide by zero
ww = -pi:(pi/500):pi; %-- omega hat frequency vector
H = freqz(bb, 1, ww); %<--freqz(bb,1,ww) is an alternative
subplot(2,1,1);
plot(ww, abs(H)), grid on
subplot(2,1,2);
plot(ww, angle(H)), grid on
xlabel('Normalized Radian Frequency')
```

For FIR filters, the second argument of freqz( _, 1, _ ) must always be equal to 1. The frequency vector $\omega$ should cover an interval of length $2\pi$ for $\hat{\omega}$, and its spacing must be fine enough to give a smooth curve for $H(e^{j\hat{\omega}})$. The MATLAB variable for frequency response is capital $H$ to be consistent with $H(e^{j\hat{\omega}})$.

Note: The filter coefficients $\{b_k\}$ are indexed from $k = 0$ to $k = M$ in (1), but since MATLAB’s vector indexing starts at one, $bb(1) = b_0$.

1.4 Windowing

The concept of windowing is widely used in signal processing. The basic idea is to extract a finite section of a very long signal $x[n]$ via multiplication $w[n]x[n]$. This approach works if the window function $w[n]$ is zero outside of an interval. For example, consider the simplest window function which is the $L$-point rectangular window defined as

$$w_r[n] = \begin{cases} 
1 & 0 \leq n \leq L - 1 \\
0 & \text{elsewhere}
\end{cases} \quad (2)$$

The important idea is that the product $w_r[n]x[n+n_0]$ will extract $L$ values from the signal $x[n]$ starting at $n = n_0$. Thus the following are equivalent

$$w_r[n]x[n+n_0] = \begin{cases} 
0 & n < 0 \\
w_r^1[n]x[n+n_0] & 0 \leq n \leq L - 1 \\
0 & n \geq L
\end{cases} \quad (3)$$

\[\text{\footnotesize{2If the output of the freqz function is not assigned, then plots are generated automatically; however, the magnitude is given in decibels which is a logarithmic scale. For linear magnitude plots a separate call to plot is necessary.}}\]
The name *window* comes from the idea that we can only “see” $L$ values of the signal $x[n + n_0]$ within the window interval when we “look” through the window. Multiplying by $w[n]$ is looking through the window. When we change $n_0$, the signal shifts, and we see a different length-$L$ section of the signal.

The nonzero values of the window function do not have to be all ones, but they should be positive. For example, the $L$-point Hamming window is defined as

$$w_m[n] = \begin{cases} 0.54 - 0.46\cos(2\pi n/(L-1)) & 0 \leq n \leq L-1 \\ 0 & \text{elsewhere} \end{cases}$$

(4)

The MATLAB function `hamming(L)` will generate a vector with values given by (4). A stem plot of the Hamming window would show that the values are larger in the middle and taper off near the ends.

(a) Make a stem plot of the Hamming window for $L = 23$, over the index range $0 \leq n \leq L-1$.

(b) Determine the maximum value of the window and the index location of the maximum. Also, determine the values of the window at $n = 0$, $n = 11$, and $n = 22$.

(c) The Hamming window is said to have *even symmetry*. What does this mean?

### 1.5 Ideal Filters and Practical Filters

**Ideal Filters** are given by their frequency response, consisting of *perfect* passbands and stopbands. The ideal filters cannot be FIR filters because there is no finite set of filter coefficients whose DTFT will be the ideal frequency response. The impulse response of the ideal LPF is an infinitely long sinc function as shown by the following DTFT pair:

$$h_i[n] = \frac{\sin(\hat{\omega}_c n)}{\pi n} \quad \Longleftrightarrow \quad H_i(e^{j \hat{\omega}}) = \begin{cases} 1 & |\hat{\omega}| \leq \hat{\omega}_c \\ 0 & \hat{\omega}_c < |\hat{\omega}| \leq \pi \end{cases}$$

(5)

where $\hat{\omega}_c$ is the *cutoff frequency* of the ideal LPF, which separates the passband from the stopband.

In the `dltidemo` GUI, you can choose ideal lowpass filters (LPF), highpass filters (HPF) and bandpass filters (BPF) because the GUI does not use the impulse response. The ideal LPFs and HPFs have one parameter for the cutoff frequency. The ideal BPF has a parameter for center frequency which determines where the band is located; its bandwidth (in the `dltidemo` GUI) is always $0.4\pi$. All the ideal filters have an additional parameter for the slope of the phase of $H(e^{j \hat{\omega}})$.

**Practical Filters** are causal length-$L$ FIR filters whose filter coefficients are chosen so that the resulting frequency response will closely approximate the desired frequency response of an ideal filter. The process of choosing the filter coefficients is called *filter design*. The practical FIR filters shown in `dltidemo` were designed using MATLAB’s `fir1` function for digital filter design. The GUI offers length-15 LPFs and HPFs, and length-21 BPFs. The LPF and HPF designs depend on specifying one parameter for the cutoff frequency which lies midway between the non-ideal passband and stopband. The BPF requires two parameters: one for center frequency which determines where the passband is located, and other for the width of the passband. In the `dltidemo` GUI, the default BPF cutoffs are $\pm 0.2\pi$ from the center frequency, so only the center frequency can be changed. These practical filters do not match ideal filters exactly, and this is readily apparent at the cutoff frequencies where the frequency response has a magnitude of 0.5.

### 1.5.1 Truncate the Ideal Impulse Response

One simple approach to designing a practical FIR filter is to truncate the impulse response of an ideal filter. This can be accomplished with a window function, so we usually say that the practical FIR filter has an
impulse response that is a windowed version of the ideal impulse response. For example, we could make a length-23 FIR lowpass filter by taking the center portion of the sinc function:

\[
h_1[n] = w_r[n]h_{\text{IDEAL}}[n - 11] = \begin{cases} 
\frac{\sin(\hat{\omega}_c(n - 11))}{\pi(n - 11)} & 0 \leq n \leq 22 \\
0 & \text{elsewhere}
\end{cases}
\]

where \( w_r[n] \) is a 23-point rectangular window. The sinc function must be time-shifted to put its peak in the middle of the window at \( n = 11 \), because we want the system defined by \( h_1[n] \) in (6) to be causal. It is common that the ideal impulse response is time shifted by an amount equal to half the window length.

(a) For the time-windowed sinc function in (6), set \( \omega_c = 0.7\pi \). Then make a stem plot of the impulse response \( h_2[n] \).

(b) Use MATLAB to determine (samples of) the DTFT of \( h_2[n] \) and make a plot of the DTFT magnitude, \( |H_2(e^{j\hat{\omega}})| \).

(c) We could experiment with different window functions. Change the window to the 23-point Hamming window, and define a new impulse response as

\[
h_3[n] = w_m[n] \left( \frac{\sin(\hat{\omega}_c(n - 11))}{\pi(n - 11)} \right)
\]

Plot the impulse response.

(d) Use MATLAB to determine (samples of) the DTFT of \( h_3[n] \) and make a plot of the DTFT magnitude, \( |H_3(e^{j\hat{\omega}})| \). Explain why this “practical filter” is a better LPF than \( H_2(e^{j\hat{\omega}}) \) when evaluated as an approximation to the ideal LPF.

1.6 GUI for Filter Design

The interactive MATLAB GUI called filterdesign illustrates several filter design methods for LPF, BPF and HPF filter. The interface is shown in Fig. 1. Both FIR and IIR filters can be designed, but we will only be interested in the FIR case which would be selected with the \( \text{FIR} \) button in the upper right. The default design method is the Window Method using a Hamming window. The window type can be selected from the drop-down list in the lower right. To specify the design it is necessary to set the order of the FIR filter and choose one or more cutoff frequencies; these parameters can be entered in the edit boxes.

The plot initially shows the frequency response magnitude on a linear scale, with a frequency axis in Hz. Clicking on the word \( \text{Magnitude} \) will toggle the magnitude scale to a log scale in dB. Clicking on the word \( \text{Frequency} \) will toggle the frequency axis to normalized frequency \( \hat{\omega} \), and also let you enter the cutoff frequency using \( \hat{\omega} \). Recall that \( \hat{\omega} = 2\pi(f_c/f_s) \). The plotting region can also show the phase response of \( H(e^{j\hat{\omega}}) \), or the impulse response of the filter \( h[n] \). Right click on the plot region to get a menu.

The filter coefficients can be “exported” from the GUI by using the menu File->Export Coeffs. To have some filters for comparison, redo the designs from the Section 1.5.1, and export the filter coefficients to the workspace under unique names. Then you can make your own plot of the frequency response in MATLAB using the freekz function (or freqz) followed by a plot command.

The \( \text{Options} \) menu provides zooming and a grid via Options->Zoom and Options->Grid.

1.7 Design Filters with the filterdesign GUI

For practice, use the filterdesign GUI to design two lowpass FIR filters with order \( M = 22 \) (or length \( L = 23 \)). Use a cutoff frequency of \( \hat{\omega}_c = 0.32\pi = 2\pi(1600/10000) \). Create one using a Hamming window,
Figure 1: Interface for the filterdesign GUI. When the Filter Choice is set to FIR, many different window types can be selected, including the Hamming window and the Rectangular window (i.e., no window). The specification of one or more cutoff frequencies \( f_{co} \) must be entered using continuous-time frequency (in Hz), along with a sampling rate \( f_s \), also in Hz). In normalized frequency, the cutoff frequency is \( \omega_{co} = 2\pi(f_{co}/f_s) \). The other with a Rectangular window which should give a result like Fig. 2. Right click on the plot to see options for displaying the impulse response either windowed or unwindowed. The unwindowed version just displays the truncated sinc function, i.e., rectangular windowing.

1.7.1 Passband Defined for the Frequency Response

Frequency-selective digital filters, e.g., LPFs, BPFs and HPFs, have a frequency response magnitude that is close to one in some frequency regions, and close to zero in others. For example, the plot in Fig. 2 is a lowpass filter whose magnitude is close to one when \( 0 < \omega < 0.883 \). This region where the magnitude is close to one is called the passband of the filter. It will be useful to have a precise definition of the passband edges, so that the passband width can be measured and we can compare different filters.

(a) From the plot of the magnitude response, e.g, in MATLAB or in the filterdesign GUI, it is possible to determine the set of frequencies where the magnitude is very close to one, as defined by \( |H(e^{j\omega})| - 1 \) being less than \( \delta_p \). This deviation from one is called the passband ripple. A common choice for the passband ripple is between 0.01 and 0.1, i.e., 1% to 10%. The set of frequencies in a passband should be a region of the form \( \Omega_{1} \leq \omega \leq \Omega_{2} \).

(b) For a lowpass filter, the passband region extends from \( \omega = 0 \) to \( \omega_p \), where the parameter \( \omega_p \) is called the passband edge. For the two LPFs designed in Section 1.7 determine an accurate estimate of \( \omega_p \) assuming a passband ripple \( \delta_p \) of 0.1 for the Rectangular window case, and \( \delta_p = 0.01 \) for the Hamming window case.\(^3\) Compare these actual passband edges to the design parameter \( \omega_c \) which is called the cutoff frequency.

Note: There is often confusion that \( \omega_c \) and \( \omega_p \) are the same, but after doing a few examples it should become clear that is not the case.

\(^3\)The filterdesign GUI has a zoom capability (Options->zoom), and the grid can be turned on (Options->grid). Also, when the pointer is placed to hover over the frequency response the coordinates are read from the plot.
Figure 2: Passband and stopband defined for a typical lowpass filter. This particular filter is a length-23 FIR filter designed with a rectangular window and a sinc function with a cutoff frequency of $\hat{\omega}_c = 0.32\pi$. The passband and stopband ripples are defined to be 0.1, from which the passband and stopband edges can be measured. The approximate value of the passband edge is $\hat{\omega}_p = 0.281\pi \approx 0.883$; the stopband edge, $\hat{\omega}_s = 0.358\pi \approx 1.125$.

1.7.2 Stopband Defined for the Frequency Response

When the frequency response (magnitude) of the digital filter is close to zero, we have the stopband region of the filter. In the lowpass filter example of Fig. 2, the magnitude is close to zero when the frequency $1.125 \leq \hat{\omega} \leq \pi$, i.e., high frequencies. When the frequency response of a LPF is plotted only for nonnegative frequencies, the stopband will be a region of the form $\hat{\omega}_s \leq \hat{\omega} \leq \pi$. The parameter $\hat{\omega}_s$ is called the stopband edge. We can make a precise measurement of the stopband edge as follows:

(a) For the lowpass filters from Section 1.7, zoom in on the plot of frequency response magnitude in the filterdesign GUI to measure the stopband edge, or use a dB magnitude plot. Then determine the set of frequencies where the magnitude is nearly zero, as defined by $|H(e^{j\hat{\omega}})|$ being less than $\delta_s = 0.1$ for the Rectangular window case, and less than $\delta_s = 0.01$ for the Hamming window design.

(b) Compare the values of $\hat{\omega}_s$ found in the previous part to the design parameter $\hat{\omega}_c$ (the cutoff frequency).

1.7.3 Transition Zone of the LPF

The difference between the stopband edge and the passband edge is called the transition width of the filter: $\Delta \hat{\omega} = \hat{\omega}_s - \hat{\omega}_p$. The smaller the transition width, the better the filter because it is closer to the ideal filter which has a transition width of zero.

(a) For the two lowpass filters from Section 1.7, determine the transition width.

Note: Comment on the statement, “when comparing equal-order FIR filters, the one with smaller transition width will have larger ripples.”

(b) Design two new LPFs that have the same cutoff frequency, $\hat{\omega}_c = 0.32\pi$, but twice the order, i.e., $M = 44$. Repeat the measurement of $\hat{\omega}_p$, $\hat{\omega}_s$ and $\Delta \hat{\omega}$ for these two LPFs.

(c) Compare to the values of $\Delta \hat{\omega}$ from part (a). When the order doubles, describe what happens to the transition width.
1.7.4 Summary of Filter Specifications

The foregoing discussion of ripples, bandedges, and transition width can be summarized with the tolerance scheme shown in Fig. 3. The filter design process is to approximate the ideal frequency response very closely. Once we specify the desired ripples and bandedges, we can draw a template around the ideal frequency response. An acceptable filter design would be an FIR filter whose magnitude response lies entirely within the template. The length-23 FIR filter shown in Fig. 3 meets the specs, but if you designed a length-19 filter it would have a transition width that is greater than $\Delta \hat{\omega} = 0.08 \pi$.

![LPF specs as a TEMPLATE (ideal cutoff at 0.32$\pi$)](image)

Figure 3: Tolerance scheme drawn around an ideal LPF with a cutoff frequency of $\hat{\omega}_c = 0.32 \pi$. Dashed lines indicate the maximum allowable deviation from the ideal LPF. The template uses $\hat{\omega}_p = 0.28 \pi$, $\hat{\omega}_s = 0.36 \pi$, and $\delta_p = \delta_s = 0.1$. The actual FIR filter shown is the length-23 FIR filter from Fig. 2 which just barely meets these specs.
2 Lab Exercise

The objective of the lab exercise is to design FIR filters that can be lowpass, highpass or bandpass filters. The exercises will involve using the GUI `filterdesign` in which FIR filters are designed via the window method, or with a computer optimization technique.

2.1 Design Two Lowpass Filters

Design two lowpass FIR filters with $M = 30$ and $\omega_c = 0.4\pi = 2\pi(2000/10000)$, one using a Hamming window, the other with a Rectangular window. For the measurement of passband and stopband edges, there are two approaches: use the `filterdesign` GUI and read numbers from the plot, zooming when necessary, or export the filter coefficients from the GUI and use MATLAB to make plots of the magnitude of the frequency response using `frekz` (or `freqz`) and `plot`. In MATLAB zooming would be more precise and reliable because the frequency sampling can be specified in the call to `frekz`.

(a) For the filter obtained with the rectangular window, determine an accurate measurement of the passband edge $(\hat{\omega}_p)$ assuming the passband ripple specification is $\delta_p = 0.1$, i.e., $1 \pm 0.1$.

(b) For the filter obtained with the rectangular window, determine an accurate measurement of the stopband edge $(\hat{\omega}_s)$ assuming the stopband ripple specification is $\delta_s = 0.1$.

(c) For the filter obtained with the Hamming window, determine an accurate measurement of the passband edge $(\hat{\omega}_p)$ assuming the passband ripple specification is $\delta_p = 0.01$, i.e., $1 \pm 0.01$.

(d) For the filter obtained with the Hamming window, determine an accurate measurement of the stopband edge $(\hat{\omega}_s)$ assuming the stopband ripple specification is $\delta_s = 0.01$.

(e) Question: is the cutoff frequency half way between $(\hat{\omega}_p)$ and $(\hat{\omega}_s)$ for both filters?

Instructor Verification (separate page)

2.2 Transition Zone of the LPF

The difference between the stopband edge and the passband edge is called the transition width of the filter: $\Delta\hat{\omega} = \hat{\omega}_s - \hat{\omega}_p$. The smaller the transition width, the better the filter because it is closer to the ideal filter which has a transition width of zero.

(a) For the two lowpass filters from Section 2.1, determine the transition width.

(b) Comment: “when comparing two $M^{th}$ order filters, the one with a smaller transition width will have larger ripples.”

(c) Design a new Hamming-window LPF that has the same cutoff frequency, $\hat{\omega}_c = 0.4\pi$, but twice the order, i.e., $M = 60$. Repeat the measurement of $\hat{\omega}_p$, $\hat{\omega}_s$ and $\Delta\hat{\omega}$ for this LPF.

(d) Compare the values of $\Delta\hat{\omega}$ from parts (a) and (c); when the order doubles, describe what happens to the transition width. Use this observation to explain that the following Hamming window design formula should be true

$$\Delta\hat{\omega} = \frac{C}{L}$$

and find the value of the constant $C$. 


2.3 Design FIR Filter to Meet Given Specifications

Filter design for lowpass filters involves five parameters: two band edges, ripple heights in two bands, and the filter order. There is a sixth factor, which is the type of filter such as a Hamming windowed FIR filter. A typical design problem would be stated as follows: given the band edges and ripple heights, determine the minimum order filter that will meet the specs.

(a) Suppose that you are given $\hat{\omega}_p = 0.68\pi$, $\hat{\omega}_s = 0.72\pi$, $\delta_p = 0.01$, and $\delta_s = 0.01$. Make a sketch of an ideal filter and a template that looks like Fig. 3. Label everything carefully and completely.

(b) Use your Hamming window design formula (from the previous section) to predict the filter length ($L$) that will be needed to meet the specs. Recall that $L = M + 1$.

(c) Design the Hamming-windowed FIR filter with the predicted order. Determine the correct value to use for the cutoff frequency. Show the frequency response to your lab instructor for verification. Explain why the resulting frequency response does or does not meet the given specs.

3 Lab HW: Filter Design via Optimization

Many different methods have been developed for filter design via mathematical optimization. One of the widely used methods is \texttt{firpm} in MATLAB. For designing a LPF, it uses the following two step process:

1. Use the desired specifications for $\hat{\omega}_p$, $\hat{\omega}_s$, $\delta_p$, and $\delta_s$ to estimate the filter order ($M$) that will be needed. This is done with the MATLAB function \texttt{firpmord}.

2. Use the outputs from \texttt{firpmord} as inputs to the function \texttt{firpm} to run the optimization and obtain the FIR filter coefficients that should meet the specs on $\delta_p$ and $\delta_s$. In effect, the inputs to \texttt{firpm} are $\hat{\omega}_p$, $\hat{\omega}_s$, $M$, and the ratio $\delta_p/\delta_s$.

For the calling arguments of these functions, do help \texttt{firpmord} and help \texttt{firpm}.

(a) Suppose that you are given $\hat{\omega}_p = 0.68\pi$, $\hat{\omega}_s = 0.72\pi$, $\delta_p = 0.05$, and $\delta_s = 0.01$. Notice that the specs on $\delta_p$ and $\delta_s$ can be different, unlike the window method that always has $\delta_p = \delta_s$.

Carry out the two design steps above to get the filter order $M$ and the filter coefficients $\{b_k\}$.

(b) Make a plot of the impulse response of the filter. Recall that the filter coefficients of the FIR filter are the values of the impulse response. Also, the DTFT of the impulse response is the frequency response of the FIR filter.

(c) Make a plot of the frequency response magnitude versus $\hat{\omega}$. Then check whether or not the ripple specs ($\delta_p$, $\delta_s$) have been met. The band edges should definitely be correct because $\hat{\omega}_p$ and $\hat{\omega}_s$ are inputs to \texttt{firpm}.

(d) If the ripple specs are not met with the predicted order, then increase the order by one and try again. A higher order such as $M + 1$ or $M + 2$ should meet the specs.

(e) The phase of this FIR filter will be linear phase. Determine the slope of the linear phase.
### Lab: FIR Filter Design GUI

#### INSTRUCTOR VERIFICATION SHEET

Turn this page in to your lab grading TA before the end of your scheduled Lab time.

Name: ___________________________  LoginUserName: ____________  Date: ______

<table>
<thead>
<tr>
<th>Part</th>
<th>Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.1(a,b)</td>
<td>Passband and stopband edges of FIR filter designed with rectangular window. Measured values:</td>
</tr>
<tr>
<td>2.1(c,d)</td>
<td>Passband and stopband edges of FIR filter designed with Hamming window. Measured values:</td>
</tr>
</tbody>
</table>

Verified: _______________  Date/Time: ____________

<table>
<thead>
<tr>
<th>Part</th>
<th>Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.2(a)</td>
<td>Transition widths of FIR filters designed with rectangular window and Hamming window.</td>
</tr>
<tr>
<td>2.2(c)</td>
<td>Passband and stopband edges, and transition width, of longer FIR filter designed with Hamming window. Measured values:</td>
</tr>
<tr>
<td>2.2(d)</td>
<td>Dependence of transition width on filter order for FIR filter designed with Hamming window. Find $C$ in $\Delta \omega = C/L$.</td>
</tr>
</tbody>
</table>

Verified: _______________  Date/Time: ____________

<table>
<thead>
<tr>
<th>Part</th>
<th>Observations</th>
</tr>
</thead>
<tbody>
<tr>
<td>2.3(a)</td>
<td>Make a sketch of ideal filter including a tolerance template like Fig. 3. <em>Draw the sketch on the axes below.</em></td>
</tr>
<tr>
<td>2.3(b)</td>
<td>Predict length of the FIR filter to be designed with the Hamming window, using $\Delta \omega = C/L$. $L =$ ?</td>
</tr>
<tr>
<td>2.3(c)</td>
<td>Give value of $\omega_o$, and show frequency response of filter to lab TA. Zoom in on passband stopband regions to verify.</td>
</tr>
</tbody>
</table>

Verified: _______________  Date/Time: ____________
Lab: FIR Filter Design GUI

LAB HOMEWORK QUESTION

Turn this page in to your lab grading TA at the very beginning of your next scheduled Lab time.

Name: __________________________ LoginUserName: ________________ Date: ______

Part 3 Design an FIR filter via optimization with `firpm`.

(a) The specs are $\omega_p = 0.68\pi$, $\omega_s = 0.72\pi$, $\delta_p = 0.05$, and $\delta_s = 0.01$. Carry out the two design steps to get the predicted filter order $M$ and the filter coefficients $\{b_k\}$.

Note: If you had to increase the filter order to meet the the ripple specs $(\delta_p, \delta_s)$, then show the impulse response and frequency response magnitude of that FIR filter, and give the value of $M$ that was used, as well as the predicted value of $M$.

(b) Hand in a plot of the impulse response of the FIR filter.

(c,d) Hand in plot(s) of the frequency response magnitude versus $\omega$. Verify that all the specs have been met; showing zoomed plots of the passband and stopband regions would be the best way to verify.

(e) The phase of this FIR filter will be linear phase. Determine the slope of the linear phase.